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1.1

1.2

Inleiding

Dit document beschrijft hoe u met Wecap XE aan de slag kunt en waar u rekening mee dient te houden voor en

na de overstap vanaf Wecap SE.

Doel
Het doel van dit document is tweeledig: enerzijds willen we potentiéle overstappers en overzicht geven van
de verschillen waarmee de gebruiker te maken krijgt, anderzijds willen we de gebruiker die overstapt een

stappenplan aanreiken, dat hij kan volgen om succesvol over te stappen van Wecap SE naar Wecap XE.

Indeling
Om beide doelen zo goed mogelijk te dienen is de inhoud van het document opgedeeld in de volgende
hoofdstukken:

1. Inleiding

Dit hoofdstuk helpt u uw weg te vinden in dit document.

2. De verschillen

Een overzicht van de voornaamste verschillen tussen SE en XE.

3. De basisinrichting

Een beschrijving van welke basisinrichting benodigd is om te kunnen starten met Wecap XE.

4. Wecap XE inrichten met gegevens uit Wecap SE

Een stappenplan dat u helpt uw gegevens over te zetten van SE naar XE.

5. Aande slag met Wecap XE

Een korte beschrijving van de voornaamste dagelijkse handelingen.
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2. De verschillen

Wecap SE en Wecap XE zijn beiden gemaakt om zo efficiént mogelijk een calculatie mee te maken. De
hoofdlijnenin het calculeren zijn niet anders in XE als in SE. Wecap XE is echter een veel uitgebreider. De

voornaamste verschillen worden in dit hoofdstuk besproken.

2.1 Gebruik
2.1.1  Bediening

Sneltoetsen
In Wecap XE worden sneltoetsen gebruikt die handiger in gebruik zijn. De sneltoetsen zijn aangepast aan de

Windows standaarden. Een overzicht van de sneltoetsen vindt u onder de menuoptie Help » Sneltoetsen.

Muisgebruik
In Wecap XE kunt u optimaal gebruik maken van de muis. U kunt onderdelen verslepen, venstergroottes

3aanpassen enzovoorts.

Contextmenu (Rechtermuisknop)
In Wecap XE wordt gebruik gemaakt van het contextmenu, beter bekend als het rechter muisknop menu. Veel

functies treft u aan door met de rechter muisknop op een item te klikken.

Panelen en Vensters
Daar waar u in Wecap SE met een vaste scherm indeling te maken had, kent Wecap XE de mogelijkheid
meerdere vensters gelijktijdig te openen of bepaalde schermonderdelen (panelen) te openen, te verbergen of

te sluiten. De bediening hiervan wordt besproken in hoofdstuk 4.

212 Werking
Naamgeving

De naamgeving van een aantal zaken zal afwijken van wat u gewend bent, onder andere:

Wecap SE Wecap XE

Importeren RSX Import RAW bestek

ZSU RAW Inschrijfstaat

Groepen Kostensoorten De vervanger hiervan in XE heet Calculatiekolommen.
Inschrijfstaat Inschrijvingsstaat, soms ook Verkoopkolom
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2.2.1

@ Wecap SE - Van Meijel Automatisering bv

Projecten Calculatie Inschrijfstaat Kostensoorten Bedriff Standaard
. & o @ v | Be Bg — AR
Projecten oo S H|% Ql[2=5* =4 X
In Wecap SE zijn er projecten en versies. leder
) i ) . J Project Calculaie  Inschrijfstaat Kostensoorten
project bevat één calculatie, maximaal 99
inschrijvingsstaten en eventueel één bestek. B B
Een projectversie is een project met hetzelfde E
nummer maar een ander volgnummer, dat zich Nummer Versie  Naam
. . . |0o0001 001 Project
verder niet onderscheidt van een ander project. 500002 001 Projedi 2
950010 |001 Vervangen riolering Colijnstr
. 950010 |002 Vervangen riolering Colijnstr
Calculaties 950010 (003 Vervangen riolering
In Wecap XE kan ieder project meerdere 00P003 [001 Onderhoud N50
calculaties bevatten. ledere calculatie(versie) Verschillende projectversies in SE
kan weer meerdere versies hebben.
S RV Vet

ledere calculatie(versie) heeft slechts één

inschrijvingsstaat, deze maakt namelijk | versie| naam

1 Riolering Colijnstraat
1 RAW BESTEK
1 Riclering Colijnstraat Alternati

onderdeel uit van de calculatie. Om meerdere

inschrijvingsstaatversies te maken dienen

meerdere calculaties te worden gegenereerd. 2 Riolering Colijnstraat Alternati
3 Riolering Colijnstraat Alternati

leder project kan slechts één bestek bevatten. 4 Riolering Colijnstraat Alternati

5 WERKBEGROTING Riclering C

Verschillende calculatie(versie)s in XE

Nummering van posten en kostensoorten

Kostensoorten

In Wecap XE is de kostensoortnummering vrij. Dat betekent dat de kostensoortcode niet 5 posities lang hoeft
te zijn en spaties, letters en leestekens mag bevatten. De basisprofielen controleren wel op een lengte van 5
posities (in verband met de werking van aansluitende pakketten in Metacom, zoals kostenbewaking) en laten in
geval van afwijking een signalering zien in de validatiekolom.

Voor meer informatie zie Validaties.

Posten

»  Dubbele postnummers worden in Wecap XE in de inschrijvingsstaatkolom niet automatisch samengevoegd.
«  Postnummers kunnen langer zijn dan 6 posities.

*  Een post kan meerdere onderliggende posten met identieke nummers bevatten.

«  Postnummers worden niet automatisch gesorteerd. Dit kan echter eenvoudig via het menu.

*  Postnummers hoeven niet direct te worden vastgelegd. Dit mag ook achteraf.

Op het voorkomen van dubbele en ontbrekende postnummers, en op postnummers met een afwijkende lengte

kan wel gevalideerd worden. U krijgt dan een signalering bij de posten die niet voldoen/dubbel voorkomen.
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2.1.2.4

2.1.2.5

2.1.2.6

2.1.2.7

Calculatieniveaus

In Wecap SE wordt de aard van de post bepaald door het niveau waarop de post geplaatst is. Het hoogste
niveau is sectie, het tweede post en het derde activiteit. In Wecap XE wordt de aard van de post niet op deze
wijze bepaald. Door het onbeperkt aantal niveaus is het mogelijk om bijvoorbeeld eerst 4 niveaus te hebben
welke secties bevatten, waarna het vijfde niveau posten bevat, terwijl in dezelfde calculatie ook posten op

bijvoorbeeld het derde niveau kunnen voorkomen.

| CALCULATIECODE |
post | omschrijving hoe'.r.| ehd. |
=0 OPRUIMWERKZAAMHEDEN
. 1010010 Slopen stallen 3,00 st
B-1 GRONDWERKEN
= 11 Grond ontwgraven
El 110 Grond ontgraven uit cunetten
= 1101 Grond ontgraven uit cunetten fietspaden
110110 Grond ontgraven uit cunetten fietspaden Lange Dijk costzijde 1.200,00 m3
E [110120  Grond ontgraven uit cunetten fietspaden Lange Dijk westzijde 985,00 m3

De aard van de post wordt bepaald door de postkenmerken, die automatisch worden gevuld, bijvoorbeeld
bij de import van een RSX bestand. Bij het handmatig invoeren van een calculatie zal een postnummer
met 6 posities eindigend op 0 automatisch als bestekspost gekenmerkt worden. Postkenmerken kunt u
altijd handmatig aanpassen. Hoofdstuk 9 en alle onderliggende posten worden automatisch als staartpost

gekenmerkt.

Inschrijvingsstaat
In Wecap XE is de inschrijvingsstaat onderdeel van de calculatie. Er is dus geen afzonderlijke inschrijvingsstaat.
Om meerdere versies van de inschrijvingsstaat te maken moet u meerdere calculatie(versie)s aanmaken die dan

elk een inschrijvingsstaatkolom bevatten.

Eindblad

In Wecap XE zult u tevergeefs zoeken naar een (standaard) eindblad. U kunt de staartposten vastleggen in de
calculatie zelf. Door gebruik te maken van een standaard calculatie met staartposten, kunnen deze automatisch
in de calculatie worden geplaatst. Hierdoor is het eenvoudig gebruik te maken van verschillende markup
mogelijkheden. Te vergelijken met een keuze uit meerdere (standaard) eindbladen bij het opstellen van een
calculatie. Zie hiervoor hoofdstuk 4.

Standaardbestanden

De standaardbestanden van Wecap XE kunt u vanuit het projectenscherm onder de menuoptie Standaarden
vinden. Als u een calculatie geopend heeft dan treft u onder deze optie echter de bestanden van de geopende

calculatie aan.

Standaardbibliotheek
Deze zult uin Wecap XE tevergeefs zoeken onder Standaarden. Wecap XE heeft een andere wijze van gebruik
van standaardbibliotheek en referentiebegrotingen. Dit zijn normale begrotingen die op speciale wijze worden

gekenmerkt. Meer hierover treft u elders in dit document en de Help van Wecap XE aan.
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2.1.2.8 Archiveren
De archiveerfunctie die Wecap SE aanbiedt na het exporteren van een project (na exporteren van de harde
schijf verwijderen) is in Wecap XE niet aanwezig. De schijfgrootte van hedendaagse computers maakt deze

functie overbodig.

2.1.2.9 Meerdere bedrijfsnamen
Deze optie in SE die het mogelijk maakt om eenvoudig onder een andere naam in te schrijven kent Wecap XE

niet. Wel kunt u onder een andere naam inschrijven, door deze handmatig op te geven.

2.1.2.10 Profielen en Views
Profielen
Wecap XE is een uiterst veelzijdig en flexibel pakket. Om een voor een specifieke werkwijze geschikte
werking te verkrijgen zijn er vele instellingen die worden vastgelegd in profielen. De in de profielen
vastgelegde instellingen bepalen hoe u kunt calculeren. In Wecap XE zijn er twee profielen meegeleverd, een
calculatieprofiel en een werkbegrotingprofiel. Deze profielen zijn zo ingericht dat de meeste instellingen voor u

verborgen blijven.

Views
Views zijn weergaven van een calculatie. De gegevens van een calculatie kunnen met behulp van een view
op specifieke wijze aan u getoond worden. Zo kunnen kolommen op een andere plaats worden getoond of

verborgen, andere kleurinstellingen worden vastgelegd en extra panelen standaard worden getoond.

2.1.2.11 Middelen
Middelen zijn een specificatie van kostensoorten. Ze kunnen per leverancier worden vastgelegd.
Middelen worden niet meegenomen naar de bewaking, waardoor het mogelijk is gespecificeerd te calculeren
en op de bovenliggende kostensoort te bewaken. Zo kunt u bijvoorbeeld een kostensoort PVC hebben met als
onderliggende middelen per leverancier de buizen en hulpstukken. U calculeert met specifieke hulpstukken en

in de bewaking bewaakt u op PVC.

2.1.2.12 Loon/materieel/brandstof
De kostensoort bestanddelen Loon, materieel en brandstof zoals u die in Wecap SE aantrof kent Wecap XE niet.
Dit kunt u ondervangen door het gebruik van het veel krachtiger onderdeel ploegen.
Indien u hiervan gebruik wilt maken dient u te werken met een standaard gekoppelde calculatie/bibliotheek. U

kunt geen ploegen vastleggen in de standaardgegevens.

2.1.2.13 Onderbouwde kostensoorten
Wecap XE biedt de mogelijkheid kostensoorten te onderbouwen met andere kostensoorten. Dit lijkt sterk op
de hieronder beschreven functionaliteit ploegen.
Een onderbouwde kostensoort is echter inclusief onderbouwing zichtbaar in de onderbouwing van de post
en een wijziging in de norm van een van de regels heeft geen invloed op kopieén van deze onderbouwde

kostensoort elders in de calculatie.
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2.1.2.14 Ploegen

Wecap XE bevat de functionaliteit ploegen. Dit zijn samengestelde kostensoorten, de kostensoort op het
hoogste niveau krijgt een eenheidsprijs die is opgebouwd uit de gegevens van de onderliggende kostensoorten
en/of middelen. Met ploegen kunt u bijvoorbeeld een asfaltploeg samenstellen en deze als een kostensoort
overal in de calculatie gebruiken. Een wijziging in de ploegopbouw werkt door in iedere post waarin de

ploeg gebruikt is. Het is mogelijk ploegen met andere ploegen te onderbouwen. Ploegen kunt u niet in

de standaardgegevens vastleggen. Wilt u toch standaard ploegen vastleggen dan dient u hiervoor een

standaardcalculatie/bibliotheek te gebruiken.

2.1.2.15 Excel gegevens gebruiken in de calculatie

Wecap XE kan op twee wijzen gegevens uit Excel gebruiken in een calculatie:

Import
In Wecap XE kunt u posten uit een Excel document dat volgens bepaalde specificaties is opgebouwd

importeren.

Koppeling

Wecap XE kan waarden van velden koppelen aan een celin een Excel werkblad. Een cel kan aan meerdere
velden gekoppeld zijn. Zo kunt u Excel als uittrekstaat gebruiken.

Zo kunt u bijvoorbeeld een inhoudsberekening opzetten in Excel en de cel met de uitkomst koppelen aan de
hoeveelheid van een post in de calculatie. Gekoppelde velden worden bijgewerkt als de celinhoud gewijzigd

wordt.

2.1.2.16 Validaties

Wecap XE kent de mogelijkheid validaties uit te voeren op bepaalde eigenschappen van onderdelen van een

calculatie. In de validatiekolom wordt een stip getoond indien er niet aan een validatie voldaan wordt.

|ksrt. | = ‘ g |ksrt‘ omschrijving hoev.ksrt. | hoev.post| hoev.heid | ehd. | ehd.prijs| herkomst prijs ehd.prijs post| totaal| '@ | Eg ‘ Ea | W
| -1 een kostensoort 1,000 T 1,00 25,00 H 25,00 [
Door op de stip te dubbelklikken ziet u de waarschuwing:
Validatie informatie n
. . . Lengte kostensoortoode is kleiner dan de ingestelde
Standaard staan in de basisprofielen van Wecap XE enkele minimale lente (5]
belangrijke validaties aan, bijvoorbeeld:
«  De lengte van een kostensoortcode
»  Aanwezigheid van een onderbouwing onder een post
2.2.1.17 CUF

Wecap XE kan calculaties weggeschreven als CUF bestand inlezen. Het CUF formaat wordt voornamelijk in de

bouw en utiliteitsbouw gebruikt. Het CUF 4.03 formaat kan worden ingelezen en weggeschreven.

2.1.2.18 BGR export

Wecap XE heeft geen exportmogelijkheid voor het BGR formaat. (VanMeijel bestandsformaat voor uitwisseling
van gegevens naar Weplan 3.x en Kostenbewaking.) U kunt gegevens naar Metacom kostenbewaking overhalen
door de calculatie in te lezen in Metacom Calculatie XE. Weplan 3.x gebruikers raden wij aan contact op te

nemen met hun VanMeijel accountmanager om de overstapmogelijkheden naar Weplan XE te bespreken.
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2.1.2.19 Excel exports en imports
Wecap SE kende diverse Excel exports. Voor ieder onderdeel was er een separate, specifieke export (0.a.
Calculatie, Kostensoorten, Inschrijvingsstaat). Wecap XE heeft een export van de gehele calculatie inclusief
inschrijvingsstaat en kostensoortenlijst naar Excel en daarnaast voor diverse onderdelen een specifieke export.

Wecap XE kan ook diverse Excel bladen importeren ten behoeve van specifieke onderdelen van de calculatie.

2.1.2.20 Afdrukken
In Wecap XE zijn alle afdrukken via de printerknop te benaderen vanuit de calculatie.
Wecap XE kent een aantal door VanMeijel gedefinieerde afdrukken, maar biedt ook de mogelijkheid afdrukken

zelf aan te passen.

In Wecap XE heeft u altijd de mogelijkheid — via dezelfde printerknop » optie schermafdruk —om een WYSIWYG
(What You See Is What You Get) afdruk van het scherm te maken. Eventuele updates van door VanMeijel
gedefinieerde prints worden meegeleverd met de update maar dient u zelf — indien gewenst — te importeren,

in de profielen waarin u deze gebruikt.

2.1.2.21 Valuta
In Wecap XE kan binnen een calculatie met meerdere valuta worden gewerkt. ltems uitgedrukt in een
afwijkende valuta worden door het programma automatisch teruggerekend naar de standaard valuta voor die

calculatie tegen de vastgelegde koersen.

2.1.2.22 Activiteitengroepen
Wecap XE kent geen activiteitengroepen. Wel kent Wecap XE sorteringen waardoor u een calculatie in een

andere volgorde kunt weergeven. Meer hierover treft u aan in de help.

2.1.3 Stadia
In Wecap XE kunt u gebruik maken van stadia om bepaalde projecten en/of calculaties read-only te kunnen

maken of om abusievelijk verwijderen te voorkomen.

2.2 Beheer

2.21  Gegevensopslag

2.2.2.1 Calculatie- en standaardgegevens
In Wecap XE worden de calculatiegegevens niet meer onder de programmamap opgeslagen. De calculaties
worden op een zelf in te stellen locatie opgeslagen. De instelling hiervan wordt aangeboden bij de eerste
maal starten van Wecap XE en is standaard '.../Mijn Documenten/Wecap XE Projecten’. De standaardgegevens
worden opgeslagen in een enkel bestand, dat u terugvindt in de map Data onder de installatiemap. Het

bestand heet CalculatieXE.std en bevat de standaardbestanden en profielen.

Indien er door meerdere personen van dezelfde pc gebruik gemaakt wordt, dient u hiermee rekening te

houden.
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2.1.2.2

2.1.2.3

222

2.2.3

224

2.2.5

2.2.6

Autoherstelbestanden
De autoherstelbestanden worden gebruikt wanneer er door een storing een beschadiging is opgetreden in een
calculatie. Het programma zal zelf aanbieden de calculatie te herstellen. Deze functie heeft het zelfde doel als

Reservekopieén in Wecap SE.

Automatische kopieén

Deze functie in Wecap XE is vergelijkbaar met de functie Automatische backup van Wecap SE.

Uitwisseling van gegevens onderling

Het uitwisselen van gegevens tussen diverse Wecap XE gebruikers wordt in een volgend hoofdstuk stap voor
stap besproken. U dient er rekening mee te houden dat het voor het uitwisselen van gegevens in interne
formaten van groot belang is dat de versie van Wecap XE op beide werkplekken overeenkomt. Daarnaast is het

aan te bevelen dezelfde profielen te gebruiken.

Instellingen

Wecap XE kent een bestand waarin alle standaardzaken zoals de profielen en de standaardkostensoorten (pas
op: dit zijn niet de kostensoorten uit een calculatie die u als bibliotheek of een standaard kenmerkt!) wordt
opgeslagen. Dit bestand heet CalculatieXE.std en kunt u vinden in de map Data onder de installatiemap van
Wecap XE. U doet er verstandig aan dit bestand mee te nemen in de backups.

Als er een andere werkplek moet worden ingericht kunt u dit bestand vanaf de ingerichte werkplek kopiéren
naar de nieuwe werkplek. Let wel op dat u hiervoor exact de zelfde versie van Wecap XE op beide werkplekken

moet hebben staan.

Multi-usergebruik

Aan een project met meerdere gebruikers worden gewerkt door middel van het opstellen van verschillende
deel calculaties. Het is niet mogelijk om met meerdere gebruikers in een deel calculatie tegelijkertijd te werken.
Eris een uitgebreidere versie — als Metacom module — beschikbaar. De calculaties zijn onderling uitwisselbaar

en de interface is gelijk.

Microsoft Windows 10
Wij raden u aan om Wecap XE te installeren op een Windows-versie die gelijk is aan of hoger dan Windows 10.

Lees hierbij wel de installatiebeschrijving!

Microsoft Office 2010
Wecap XE ondersteunt niet langer het oude Excel xls-formaat, maar werkt enkel met xlsx-bestanden. Daarom

raden wij u aan om hiervoor minimaal Microsoft Office 2010 te gebruiken.
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3. Basisinrichting

In dit hoofdstuk is beschreven welke basisinrichting benodigd is om te kunnen starten met Wecap XE.

Advies: Omdat er vaak specifieke inrichtingsvragen zijn per bedrijf, is het advies om gebruik te maken van een

VanMeijel consultant. U kunt contact hierover opnemen met onze supportafdeling.

3.1 Basis profielen
Standaard worden bij de installatie tweetal specifieke profielen meegeleverd welke gebruikt kunnen worden.
Deze standaard profielen staan in de Map “Demo” in de installatie directory van Wecap XE. Om gebruik te

kunnen maken van deze profielen dienen deze geimporteerd te worden in Wecap XE.

» [This PC » Local Disk (C:) * Program Files (x88) » VanMeijel » Wecap XE » Demno
Mame Date modified Type
ESS
r 2 D demo_biblictheek.vmacal 2-4-2020 10:56 WMACAL File
5
| | dermo initymacal 2-4-2020 10:56 YMACAL File
* D GWW-Basis.wrnacalprl 15-4-2020 16:08 YMACALPRL File
pts * D GWW-Werk.wracalprl 15-4-2020 16:08 YMACALPRL File
L i
3.1.1  Inrichten en importeren basis profielen Wecap XE - [Profielen]
’ Start Wecap XE Bestand | Bewerken Opties View VMensters Help
’ P Alles inklappen
2. Kies 'Standaarden’ » ‘Profielen’ Alles uitidappen
3. Kies ‘Bewerken' » Importeer M HE IR i
code Exporteer | omschij
|| -BaE ————— B&W - Ui
- BRUL = Kopieer  Ins B&WU - Ui
| -Bawon3 B&U - Ui
Importeer profiel X B
Profiel: |C:\Program Files (x86)\VanMeijel\Wecap XE\Demo\G\I| [ 5 *—-r——’-—"
4. Klik op heticoon om de
Importeer: w2 Importeer profiel
‘Bestand Openen’-dialoog te 8 importer pofi x
Look in: | Demo V| (< Nz M=l
openen. Profielcade: Name . Date modified Type
5. Selecteer het bestand Omschrijving: * [ GWW-Bzsis.vmacalprl 15-4-2020 16:08 VMA
., ) Niveats Quickaccess ™ Guny-werk.vmacalprl 15-4-2020 16:08 VMAS
GWW-Basis.vmacalprl” en ' m
klik op ‘Open’ Desktop
e
Libraries
This PC
Dit bestand staat in de Map #
“Demo”, in de installatiemap Network |
File name: 5 WW-Basis.vmacalprd
van Wecap XE. Files of type: | Profiel - | | Cancel |
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6. Voer de profielcode +

Importeer profiel X
omschrijving van het profiel in
en Klik op ‘OK’ Profiel: 36)\VanMeijel\Wecap XE\Dema\GWW-Basis.vmacalpr| pt
Importeer: (®) Als nieuw profiel
() Vervang profiel BUOO1
Profielcode: |GWW-Basis
Omschrijving: |GWW—Basis calculatie en inschrijving|
Miveaw: @® Systeem
(O Bedrijf
oK | | Annuleren | | Help
. Wecap XE - [Profielen] - [m] x
7. Selecteer het GWW-Basis Bestand Bewerken Opties View Vensters Help =3 x|

profiel. Druk op de stadium

: Sik-. === el -
knop en zet het stadium op e | Zet stadium van pr:ﬁe\ GWW-Basis - GWW-Basis calculatieen i.. X 8
code um
‘Definitief'. Klik op ‘OK'. | | +-Bewonr Bl O oorlopig el
| -Bawoe2 B o ottt lfinitief
BAUO03 B lefinitief
i BAUNM g{ (O Blokkeren voby gebruik \efinitief
) || i B&WODS B{ O Teverwijderen lefinitief
U kunt er voor kiezen om de | -Bawos Bl efinitief
|| - Gwwoot G lefinitief
overige profielen (B&UO... - Guowone g [ o ] [amueren| [ rep pfinitef
. || - GWwoo4 GWW - Werkvoorbereiding Systeem
en GWWO...) op het stadium | |- cwwoos T S
| | i~ 1D001 ID - Diensten Calculatie Systeem
”Voor[op]g” te zetten, || -sTagv STABU bestek Systeem
|| - RAW BESTEK RAW BESTEK Systeem Definitief
zodat de profielen niet i e “ - Pt
worden aangeboden bij het
aanmaken van een nieuwe
calculatie.
8. Sluit het profielenscherm Wecap XE - [Profielen]

Bestand Bewerken Opties View Vensters Help

‘ Openen,.. Ctrl+0

Owerall...
Bk Ctrl+F4 v
H Opslaan Ctrl+S |n'rueau |waal
' [ opsiaan zs.. / Raming Systeem
aleulatie Systeem
Afdrukinstellingen... mat / Offerte Systeem
B Afdrukken... Ciglop  pereiding Systeem
il a T Ca e,
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4.1

4.2

Wecap XE inrichten met gegevens uit Wecap SE

In dit hoofdstuk wordt beschreven hoe u gegevens uit Wecap SE kunt overzetten naar XE.

Het is op diverse manieren mogelijk gegevens uit Wecap SE te gebruiken in Wecap XE. Daarnaast biedt
Wecap XE diverse manieren om met standaardgegevens om te gaan. Hieronder wordt een goede werkwijze
beschreven.

Standaardkostensoorten
Als u de standaardkostensoorten uit Wecap SE wilt overnemen in Wecap XE kunt u dat het beste gelijktijdig

met de standaardbibliotheek doen, zoals hieronder beschreven.

Standaard bibliotheek

42.1  Qverzetten van Wecap SE naar Wecap XE

Om de standaardgegevens van Wecap SE in Wecap XE te kunnen gebruiken, gaat u als volgt te werk:

1. Start Wecap SE

2. Klik op Annuleren om het projectenscherm te sluiten

——

i
« m >

3. KiesStandaard » Im-Export » Exporteren standaardgegevens

E Wecap SE - ¥an Meijel Automatisering bw

Projecten  Calculatie  Inschrifstaat  Kostensoorten  Bedrijf | Skandaard  ‘Werkbegroting  Opties  Eshesr Help
+ I = oy —_—
[E2faxnn ruen =G Hass ==
Eibliokhee

»

3

J Frojezt [zl atie |rechnjfztast Kosteneoorten Eindblad r
»

*

Instelingen

Im-export Importeren standaardaegeyens

Inchecken

Exporteren standaardgegevens

Save As HE
4. Kies een locatie en klik op Opslaan e IMwmwmw o E
(24 Mijn afbeeldingen
|5 5naglt Catalog
|5 Wecap ¥E Projecten

5. Klik op Exporteren

Exporteren standaardbibliotheek Bursaublad

Miin

documenten

=] [ e |
j Annuleren
Code Page

VA

Evpotteren

Annuleren | Min Bestandsnaam | S

netwerklocaties

Dpslaan als type: ooy

6. Start Wecap XE
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7.

Wecap XE - [Calculatieprojecten]

Maak een nieuw project aan door in de bovenste knoppenbalk op het = icoon te klikken

Ee;tand Standaarden Vensters Help

o HE

B OB =

| projectnr

v naam

‘ datum aanb dir

[v]e

| opdrachtgever

| umschlijv&

| calculator | Mmemc

8.

Voer een nummer (bijvoorbeeld: StdProject) en omschrijving in

Wecap XE - [Calculatieprojecten]

Eestand Standaarden Vensters Help

EHS

projectnr naam .| datum aanb
w ;

B OB >

tach

Standaard Project

9.

Maak een nieuwe calculatie aan door in de onderste knoppenbalk op het =+ icoon te klikken
Wecap KE - [Calculatieprojecten]

Eestand Standaarden Vensters Help

o HE

B 08 >

projectnr | naam
»

Standaard Project

a
.l datum aanbstedlng.l besteknummer .l opdrachtgever

.l calcula‘lal.l memo

[T

1

code

>
=B
velsiel naam |type ‘ opdrachtgever | memo |sla
Selecteer profiel X
Profiel: % GWW-Basis calculatie en inschrijving
I QK | | Annuleren | ‘ Help ‘

10. Kies het profiel 'GWW-Basis’ en klik op OK
11.

Voer een naam (bijvoorbeeld: ‘Standaard Bibliotheek’) en een omschrijvingin

versie|

>
= 8
CALCULATIES
‘ omschrijving

naam

||'ype ‘ opdrachtgever
|| Standaard Bibliotheek

| memo |s|adium
Inschrijfstaat Voorlopig

Overstappen van Wecap SE naar Wecap XE
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12.
13.

14.

15.
16.

17.

Open de calculatie door op de regel te dubbelklikken.

Ga naar Extra » Calculatie instellingen.

Wecap XE - [Calculatie StdBib.T.vmacal]

Eestand Bewerken Begld View | Extra Standaarden Vensters Help

HEHE =

StdProject - Standaard
5tdBib - Standaard Eib

Project:
Calculatie

Kostprijs + Inschrijvingsst ﬂ Calculatie instellingen

Automatisch onderbouwen
Bestek naar tweede niveau
Zet kenmerk bewaking o.b.v. lengte code

Bijwerken prijzen

Kies Diversen profiel » Onderbouwing » Calculatiekolom en zet de instelling ‘Ongebruikte kostensoorten

automatisch verwijderen’ op ‘Nee’.

Instellingen calculatie - StdBib Standaard Bibliotheek

naem id oorsprong waarde
= Diversen profiel
| | Prizen
Autoherstel / kopie
[ Posten
| # Afronden aantal decimalen
| | = Onderbouwing/calculatickolom
[ Gebruik productienorm 23 . Ja
[ - Initiéle waarde productienorm 197 . |
[ Opnieuw bepalen van kostensoort na wijzigen middel 263 . Nee
| | ® Standaard leverancier middelen
[ Normregels sorteren op 198 . Invoer
|| -~ Standaard methode voor wijzigen eenheidspris 45 . Kostensoort/middel
[ Afwijkende methode voor wijzigen eenheidsprijs middel 73 . N,
[ -~ Standaard methode voor wijzigen factor eenheidsprijs 151 . Postspecifiek
[ Afwijkende methode voor wijzigen factar eenheidsprijs middel 274 . N,
v ¥ Cngebruikte kostensoarten automatisch verwijderen 55 . Ia ~
[ Ongebruikte middelen automatisch verwijderen 56 . Ja
[ - Ongebruikte leveranciers automatisch verwijderen 331 .
: Afcoderen normregels 192 3 Nee
B - el i il e N
Klik op OK.

Kies nu Bestand » Import » MCU...

Wecap XE - [Calculatie StdBib.1.vmacal]

Bestand Bewerken Beeld View Extra Standaarden Vensters Help

;P‘t Openen... Ctrl+Q
Overall...
M Py Sluiten Ctrl+F4
H Opslaan Ctrl+5
m Opslaan als...
Afdrukinstellingen...
= Afdrukken... Ctrl+P

- [ Eigenschappen

CUF4...

Export 3 MCU...
PE -V S TS S T T TR ST - SO 1 AL s

Klik op het p icoon om de Bestand Openen dialoog te openen.

Import MCU

Bestand |

Koppelen kolommen

/

MCU bestand

[~ [|xe |

[w

Lange cmschrijving calculatie

LN, NN S Y A

Memo calculatie

R SRR Y

Overstappen van Wecap SE naar Wecap XE
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18. Selecteer het bestand dat u in stap 3 heeft opgeslagen en klik op Openen.

19. Klik vervolgens op OK.
20. Sluit de calculatie.

Wecap XE - [Calculatieprojecten]

Bestand Standaarden Wensters Help

( ¢ Openen... Ctrl+0
Owerall...
Ctrl+F4
_ H Opslaan Ctrl+5S
_I m Opslaan als...
Afdrukinstellingen...
= Afdrukken... Ctrl+P

[i] Eigenschappen

| daturn g

21. Klik vervolgens op Ja (of Yes) bij de vraag of de calculatie dient te worden opgeslagen.

Bevestigen

P ) Er zijn gegevens van 5tdBib.1.vmacal gewijzigd, opslaan?

*

=

Ja ; | Mee | | Annuleren

Overstappen van Wecap SE naar Wecap XE
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422 Opnemen kostensoorten in onderbouwing ten behoeve van onderhoudbaarheid

Naamgeving

U kunt nu alle kostensoorten uit deze bibliotheek gebruiken. Om echter de kostensoorten goed te kunnen
onderhouden, bijvoorbeeld om procentuele verhogingen te kunnen doorvoeren, dient u de kostensoorten
rechtstreeks in een onderbouwing op te nemen.

U kunt hiertoe het beste als volgt te werk gaan:

1.  Open de calculatie StdBib

2. Maak een nieuwe post aan op het hoogste niveau met de omschrijving Kostensoorten

CALCULATIECODE

post | omschrijving
- 11 Sloopwerk

; Kostensoorten
|m-1111 Algemeen
@121 Metselwerk
@ 1122 Betonwerk

3. Maak hieronder posten aan met als code het nummer van de groep kostensoorten en als
omschrijving de omschrijving van deze groep, bijvoorbeeld:
U kunt zoveel groepen/posten aanmaken als u zelf prettig vindt. Er is geen verband met

calculatiekolommen (de vervanger van groepen kostensoorten, zoals u die kent uit SE)

=- Kostensoorten
- 1 Materieel
- 2 Lonen
- 3 Leveranties
N 4 Onderaanneming
; [s Diversen
BEREE Algemeen

Open nu de eerste post
Ga naar de onderbouwing door in het onderbouwingspaneel te klikken.
Druk op [F7]

A

Selecteer de kostensoorten die in deze groep thuis horen.

Klik op de eerste kostensoort van de groep, houd de [Shift] toets ingedrukt en klik op de laatste
kostensoort die in de groep hoort.

8. Klik vervolgens op [OK] om de kostensoorten naar de post te kopiéren.

9. Herhaal de stappen 4 t/m 8 voor alle overige posten onder Kostensoorten.
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4.2.3

4.2.4

Standaardgegevens koppelen aan nieuwe calculaties

Om deze bibliotheek standaard bij nieuwe projecten te koppelen, gaat u als volgt te werk:

F Wecap XE - [Calculatie In.Infiele calculatie. T.vmacal]
2 Bestand Bewerken Beeld View Extra | Standaarden Vensters Help

1. Maakin het zelfde project een nieuwe lege

calculatie aan, zie de stappen hierboven, en noem Kostprijs + Inschrijvingsstaat g Legmaian
Middelen
deze bijvoorbeeld init — initiéle calculatie FEHE B M FE Leveranciers
. 7% Kpstensoorten/middelen
. . Pi ct: StdPy ct - Standaard P a 0
2. Open de calculatie door er op te dubbelklikken i e e %Y B Eenheden
. . = Valuta
3. Kies Standaarden » Gekoppelde calculaties oo
% Btw codes
4. Voeg een regel toe door op ‘Insert’ te drukken [IF Sorteringen '
9 9 P ¥l Formules en variabelen Ctrl+6 -
5. Voereennaamin en gain het vakje bestand staan. post omschriping e hoe)
6. Klik op de ===|knop. Het standaard dialoogvenster ¥ Instellingen

Reactiveren meldingen

Bestand openen wordt getoond.

7. Ganuinditvenster naar de lokatie waar uw

projecten worden opgeslagen.
Bij een standaardinstallatie is dit: *...\Mijn Documenten\Wecap XE Projecten*’
* De map Mijn Documenten kan een andere naam(lokatie) hebben afhankelijk van de instellingen van
Windows.

8. Open de map met de naam van het standaardproject (bijvoorbeeld: StdProject)

9. Selecteer de calculatie die de standaardbibliotheek bevat (bijvoorbeeld StandaardBib) en klik op Openen

10. Vink het vakje standaard bibliotheek aan en het vakje prijsmechanisme.

11. Klik op OK en sla de gegevens op

12. Gavervolgens naar het projectenscherm

13. Kies Standaarden » Profielen

14. Selecteer het profiel waaraan u deze standaardgegevens wilt koppelen en kies Instellingen Profiel in het
rechter muisknopmenu

15. Kies Diversen profiel » Calculatie initieel vullen met en selecteer nu de nieuwe (in punt 1) aangemaakte
calculatie

16. Klik op OK

ledere nieuwe calculatie met dit profiel heeft nu onder F9 de kostensoorten uit de bibliotheek.

Tip: In de calculatie uit punt 1 kunt u ook andere standaardgegevens opnemen die in iedere calculatie

gebruikt dienen te worden.

Import RAW catalogus
In Wecap SE staat de RAW catalogus vaak in de Standaardbibliotheek. Als u deze overneemt zoals in paragraaf
4.2.1 heeft u dus direct de beschikking over de RAW Catalogus. Het is niet mogelijk de RAW catalogus direct in

Wecap XE in te lezen.
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425 Standaard calculatie en - eindblad

7 8 'WERK ALGEMENE AARD
[ =9 Staartposten
In Wecap SE kon u een standaard vast- en een standaard e ERNMALGE KOSTEN
» 910010
variabel eindblad inrichten, dat gebruikt kon worden bij Ho Do ol
919990 100,00 EUR N
nieuwe calculaties. In Wecap XE kennen we dit niet. Het H " Tamm  Ummoretoro T
. . . | B8 Algemene kosten
eindblad maakt onderdeel uit van de calculatie.U heeft de o MWER N

mogelijkheid iedere calculatie, gebaseerd op een bepaald

Onderbouwing
'ONDERBOUWING
profiel, te voorzien van de inhoud van een standaardcalculatie ‘ B oy Lt o]l memedod |

ks,
| -[71050 keet 300,000 T 300,00

en dus ook van een standaard staart. Voor het gebruik van
) ) Voorbeeld van een standaard RAW eindblad
een standaardcalculatie, zie paragraaf 4.2.3

Bij het inlezen van een RSX-bestand, zullen de staartposten van het RSX worden samengevoegd met de door
u vastgelegde staart. Hierbij worden de door u opgevoerde gegevens in de staart van het bestek verwerkt,
waarbij de correcte teksten zullen worden aangehouden. De exacte werkwijze bij het samenvoegen treft u aan

in de Help. (onderwerp: RAW Bestek » Staartposten samenvoegen)

4.3 Kostensoortgroepen
De (standaard)groepen kostensoorten zoals u die kent uit SE zijn in XE komen te vervallen. Wecap XE kent een
optie welke gedeeltelijk met kostensoortgroepen overeenkomt: de calculatiekolommen.

Bij aflevering kent Wecap XE 5 calculatiekolommen, te weten:

Label Kostensoort van
Materieel 0
Lonen 2
Leveranties 22
Onderaanneming 8
Diversen 9

In Wecap XE worden de calculatiekolommen per view vastgelegd. Wilt u deze indeling muteren dan dient u dit

dus per view te doen.

U kunt de indeling van de kolommen als volgt aanpassen:

1. Start Wecap XE

Kies in het menu Standaarden » Profielen

Selecteer het profiel GWW-Basis

Kies in het menu View » Kostprijs + Inschrijvingsstaat

Klik nu met de rechter muisknop in het venster en kies voor Instellingen view
Klik op het plusje voor Posten

Klik op het plusje voor Band Materieel

U kunt nu achter Label de juiste omschrijving van de groep kostensoorten aangeven.

v o N oA W

Achter Zichtbaar moet Nee staan

N
o

. Achter Standaard kostensoort dient u een kostensoort uit de standaard aan te geven die het juiste
kostensoorttype heeft. Standaard kostensoorten legt u vast door in het projectenscherm te kiezen voor
Standaarden » Kostensoorten.

11. Geef achter kostensoorttype het juiste type aan dat bij deze kostensoorten hoort
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¥ Band ARBEID
I Band MATERIEEL

b

B  Zichtbaar 15 Nee

| Standaard kostensoort 0 10000
|| = Kostensoorttype 26 Materieel
| Kostensoort van 2% 10000

i Kolom ksrt (ksrt)

12. Geef achter Kostensoort van het laagste nummer aan dat bij de groep hoort (in dit geval kunt u dit veld
leeg laten, hetis immers de eerste groep)
13. Herhaal de stappen 7 t/m 12 voor de volgende groepen. Indien u meer groepen wenst vast te leggen dan

er standaard zijn (t/m band Diversen) dan dient u deze eerst aan te maken zoals hieronder beschreven.

43.1  Toevoegen calculatiekolommen
1. Start Wecap XE
2. Kiesin het menu Standaarden » Profielen
3. Selecteer het profiel GWW-Basis
4. Kiesin het menu View » Kostprijs + Inschrijvingsstaat
5

Klik nu met de rechter muisknop in het bovenste deel van het venster en kies voor NormCalculatieKolom
toevoegen

De kolom is nu toegevoegd en kunt u terugvinden in de profielinstellingen als hierboven beschreven onder de

naam Band Groep 6 (het nummer is afhankelijk van het aantal kolommen dat al bekend is)
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4.4 Calculaties

U kunt uw oude calculaties uit Wecap SE inlezen in Wecap XE.

Opmerkingen:
*  De kostensoortgroepsindeling wordt niet meegenomen
«  Aangezien Wecap XE anders afrondt dan SE zullen er verschillen in de bedragen zitten!

De afronding zit in de hoeveelheid van de kostensoort in de onderbouwing.

Ter illustratie hieronder een voorbeeld:

Wecap SE
- 2114 Riclering algemesn [RTaRE]
211410 Aanbrengen grondverbetering. 13300 m3 W 513 E82.E0
211420 Aanbrengen putrand met deksel. 7,00 st 115,90 811,30
211430 Aarvvullen sleuven en bouwput. 151400 m3 W 335 5.077.28
- 212 kOLE- EM HUISAAMSLUITINGEN 737673
212110 Ortaraven thyv. kalk- en huizaagsluitingen. 185,00 m W 4.5 786,68
21120 Yerwijderen aresbuiz kalk- en huisa ifingen. 170,00 m W 522 aav.0n
212130 Wenawijderen huizaanzluitingen PVC 125 en 14,00 m W 339 47 50
212140 Werwideren straat- en trottairkolken, 9.00 st W 17.78 160,00
212150 Aanbrengen kalk van beton/gietiizer combinatie, 9,00 st W 103,00 927.00
212160 Aanbrengen kolk- en huizaansluitingen PVYC 125 mm. W 18,65 3.337.67
212161 aanbrengen leiding 178,00 m 9,35 167332
[_Ksit ]| i |,95‘| rj|Elmschriiving |@| Hoewkart)  Hoew.post |,§’| HoeveelheidlEhd Totaal ]|
10000 * mob.kraan 1,00 60,00 2,22 uur 20,00 17760
20130 . |gr0ndwerker | 8.00 133.00 800 ur 47 50 SSD,DD|
+ il ar

Rekenmethode:
De kraan ontgraaftin 1 uur 60 m?, dat betekent 133m? (posthoeveelheid) in 133 / 60=2,2166666666

SE rondt dit af op 2 decimalen. Het bedrag is dan 2,22 * 80 = 177,60

Wecap XE
Riolering algemeen 66.215,28
Aanbrengen grondverbetering ~, 13300 m3 513 682,33

Aanbrengen putrand met deksel 3,35 23,45
425 65.500,50

971.25

Aanvullen sleuven en bouwput
KOLK- EN HUISAANSLUITINGEN

ONDERBOUWING
B |ksrt. omschrijving hoev.ksrt.| hoev.post|  hoev.heid|ehd. | ehd.prijg|h... | ehd.prijs pot totaal|' @ |Fa
mob., kraan 1,000 &0,00 2,22 uur 80,00 H T 177,33
grondwerker 8,000 133,00 8,00 uur 47,50 H 2,86 380,00
trilwals 2 ton 1,000 133,00 1,00 dag 125,00 H 0,94 125,00

Rekenmethode:
De kraan ontgraaftin 1 uur 60 m?, dat betekent 133m? (posthoeveelheid) in 133 / 60=2,2166666666

Het bedrag is dan 2,21666666666 * 80 = 177,33
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U gaat als volgt te werk:

1. Start Wecap SE
2. Open de gewenste calculatie
3. Alsuditwilt kunt u de projectgegevens overnemen voor gebruik bij het XE project
4. Kies Projecten » Exporteren project
5. Kies een locatie en klik op Opslaan
6. Start Wecap XE
7. Maak een nieuw project aan door in de bovenste knoppenbalk op het =" icoon te klikken.
Wecap XE - [Calculatieprojecten] - O
»o Bestand Standaarden Vensters Help
M HS B DH=>
|plojectnl | naam |0I‘|‘ISChlijk ‘ datum aanbestedil !:”" k |opdlachtgever |ca|culatm
£
8. Neem eventueel de gegevens over die u onder stap 3 genoteerd heeft.
9. Maak een nieuwe calculatie aan door in de onderste knoppenbalk op het =** icoon te klikken en voer een
nummer en een omschrijving in.
projectnr | naam | datum aanbsleding‘ besteknummer ‘ opdrachtgever | calculalol‘ memo
4 Standaard Project
<
code | versiel naam ‘type | opdrachtgever | memo
|
10. Open de nieuwe calculatie door er op te dubbelklikken  |import mcu X
11. Kies nu Bestand » Import » MCU... Bestand e
12. Klik op het p icoon om de ‘Bestand Openen’-dialoog | .0 ien kolommen
te openen. MCU bestand -] -1
. |#|Lange omschrijving calculatie Memo calculatie
13. Selecteer het bestand dat u in stap 3 heeft opgeslagen | |Meme calculatie Combinanten
. | |Lange omschrijving post Interne memo post
en klik op ODenen. | [Meme post Externe memo post
14. Klik VerVOlgenS op oK | |Lange omschrijving kostensoort  Omschrijving kostensoort
: || Memo kostensoort Memo kostensoort
Als u het project alleen als referentie wilt gebruiken voor oK Annuleren | | Help

onderbouwingen en/of prijsniveau bent u nu klaar.
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Wilt u verder werken met het project dan moet u nog de volgende stappen nemen:

1.

In Wecap XE is het verplicht de structuur volgens bepaalde richtlijnen op te bouwen. Dat betekent dat er
een hiérarchische structuur moet zijn voor de posten. Er mogen geen lege secties zijn, zoals Wecap SE deze
kent. Sectie 11 dient onder sectie 1 te hangen enz.

U moet nu zelf deze structuur aanbrengen door secties naar de juiste positie te verslepen.

Het variabel eindblad van SE wordt niet overgenomen naar XE.

U dient dit handmatig vast te leggen in de staartposten van de calculatie.

De inschrijvingsstaten worden niet meegenomen bij de import. De Verkoopkolom wordt wel gevuld maar
niet met prijzen uit (één van) de inschrijvingsstaten.

U dient deze handmatig in te geven of in een nieuwe calculatie te importeren (in dit geval komen wel de
correcte prijzen over maar kunt u niet calculatie en inschrijvingsstaat naast elkaar zien). Heeft u meerdere

inschrijvingsstaten dan dient u per inschrijvingsstaat een nieuwe calculatie aan te maken binnen XE.

De meest voor de hand liggende manier is nu om, per inschrijvingsstaatversie, de volgende handelingen uit te

voeren:

1. Start Wecap SE

2. Opende calculatie

3. Open de Inschrijvingsstaat

4. Kies de correcte versie.

5. Kies Inschrijfstaat » Exporteren

6. Kies bij Opslaan als voor ZSU

7. Selecteer een locatie en klik op opslaan

8. Start Wecap XE

9. Selecteer het project door er op te klikken

10. Maak een nieuwe calculatie aan door in de onderste knoppenbalk op het =+ icoon te klikken en voer een
nummer en een omschrijving in.

11. Open de nieuwe calculatie door er op te dubbelklikken

12. Kies Bestand » Import » RAW Inschrijfstaat...

13. Klik op het p icoon om de Bestand Openen dialoog te openen.

14. Selecteer het bestand dat u in stap 3 heeft opgeslagen en klik op Openen.

15. Klik vervolgens op OK

Het bestek wordt niet overgenomen

U dient het bestek dus alsnog te importeren, ga hiervoor als volgt te werk:

1.
2.

v o N ook

Start Wecap XE

Selecteer het project door er op te klikken

Maak een nieuwe calculatie aan door in de onderste knoppenbalk op het =+ icoon te klikken en voer een
nummer en een omschrijving in.

Open de nieuwe calculatie door er op te dubbelklikken

Kies Bestand » Import » RAW bestek...

Maak alle aankruisvakjes leeg

Klik op het g icoon om de Bestand Openen dialoog te openen.

Selecteer het bestand dat u in stap 3 heeft opgeslagen en klik op Openen.

Klik vervolgens op OK
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5. Aan de slag met Wecap XE

Aan de hand van een voorbeeld wordt u stap voor stap door Wecap XE geloodst en leert u de meest
gebruikte fFuncties kennen. Voorwaarde is dat u Wecap XE al heeft ingericht zoals staat beschreven in

het voorgaande hoofdstuk.

5.1 Aanmaken project

Klik op =" omeen project toe te voegen, in de bovenste knoppenbalk.

Wecap XE - [Calculatieprojecten] — O

ha Bestand Standaarden Vensters Help

HHE B O0OH >
|pmjeclnl |naam |omschlijvin\ | datum aanbestedi :,!:”" k |0pdlachtgevel |ca|culator {

Er verschijnt een nieuwe lege regel, waarop de naam van de calculator al is ingevuld.

Voer nu de volgende gegevens in:

Label Invoer

Projectnr demo01

Naam de eerste stappen in Wecap XE
Datum aanbesteding 01-12-2009

Besteknummer Vul hier niets in.

Het besteknummer wordt automatisch gevuld bij inlezen van het RSX.

Opdrachtgever Ons Dorp

Eestand Standaarden Vensters Help

EHS ®OH =
|pmjectnl | naam | datum aanhsteding| besteknummer | opdrachtgever | calcula‘tcnl:
¥ Demoll de eerste stappen in Wecap XE 1-12-2020 OW/2020.006 Ons dorp gebruiker
StdProject Standaard Project gebruiker
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5.2 Aanmaken calculatie
Maak een nieuwe calculatie aan door in de onderste knoppenbalk op het icoon te klikken.

Het volgende dialoogvenster verschijnt:

Selecteer profiel *

Profiel: % GWW-Basis calculatie en inschrijving

I oK | | Annuleren | | Help

Kies hier voor GWW-Basis en klik op [OK]

Een nieuwe regel verschijnt, voer nu de volgende gegevens in:

Label Invoer

Code Kostprijs

Versie 1 (ongewijzigd laten)
Naam Demo kostprijscalculatie
Type Inschrijfstaat (ligt al vast)
Opdrachtgever Ons Dorp (is al ingevuld)

De overige velden kunt u ongewijzigd laten.

Open nu de calculatie door op de regel te dubbelklikken. Het calculatiescherm verschijnt:

Wecap XE - [Calculatie Kostprijs.Demo kostprijscalculatie.].vmacal] - o X

B Bestand Bewerken Beeld View Extra Standaarden Vensters Help _|=|x

rijs + Inschrijvingsstaat Kostprijs Inschrijvingsstaat
B H S BOEe>>508|C <
Project: demo01 - de eerste stappen in Weeap XE Calculatie Inschrijfstaat
Caleulatie Kostprijs - Demo kostprijscalculatie - 1 Subtotaal 0,00
Staart 0,00
Kostprijs 0.00  Subtotaal 0.00
Indirecte kosten 0.00  Staart 0.00

Aznneemsom [ Aanneemsom () 0,00
CULATIECODE CALCULA NSC STAAT

post omschrijving hoev|ehd. [V | ehd.pris| totaal|'¢|Ee|Be | v |ehd. hoev.resverpl. [V | prijs per ehd. totaalbedrag| werschil

aneuoyuisod

Onderbouwing 0 x
ONDERBOUWING

ksrt. | = | Kg [ksrt. omschrijving | hoev.ksrt. | hoev.post| hoev.heid| ehd. | ehd.prijs| herkomst prijs | ehd. prijs post| totaal| '@ | Fo | Bp | v

Productienorm: 1,00

Onderbouwing | Kostensoorten
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5.3 Inlezen RSX
We gaan nu een RSX inlezen.

1. Kies hiervoor Bestand » Import » RAW Bestek...
2.

Wecap XE - [Calculatie 001.Kostprijs.1.vmacal]

Bestand Bewerken Beeld View Extra S5Standaarden Wensters Help
;Pi Openen... Ctrl+ 0

Qwerall...
I By Sluiten Ctl«F4 [ % W T v (]
H Opslaan Ctrl+5

EI Opslaan als...

Afdrukinstellingen...
= Afdrukken... Ctrl+P

" [ Eigenschappen _

urs.

Export 3 MCU...
1.\Projectendirectories\Wecap ..\001.1.vmacal RAW bestek...

2 .\Projectendirectories\Weca..\2222.1.vmacal RAW deelopdracht

3 .\Projectendirectories\W...\3456546.1.vmacal Mota van inlichtingen
4

AAGAUsershemeij.. Avastzetten.v2018.vmacal
! BAW inschrijfstaat...

3 .\Projectendirectories\...\vastzetten.1.vmacal

3. Selecteer vervolgens het bestand demo0.RSX dat u aantreft [aanvullen] en klik op Openen.

4. Hetvolgende dialoogvenster verschijnt:

Importeren RAW bestek >

Bestand |C:\temp\demoﬁ.rn¢ | B

Calculatie direct vullen vanuit bestek
Hoeveelheden ter inlichtingen importeren
Bundelposten importeren

[J Calculatie automatisch enderbouwen

| oK | | Annuleren | | Help

5. Klik op OK om verder te gaan.

Het bestek en de calculatie worden gevuld. Hierna verschijnt het bestek op de voorgrond. U kunt hier de
complete bestekstekst raadplegen. In dit voorbeeld wordt hier verder niet op ingegaan.

6. Sluit nu het bestek door op het kruisje rechts boven in het scherm te klikken:

Inschrijfstaat

7. Druk vervolgens op de * toets bij het numerieke toetsenblok om alle posten uit te klappen.
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5.4 Calculeren

1. In het calculatiescherm selecteert u post 200010 met behulp van de cursortoetsen of door met de muis

voor de regel te klikken:

| amschrijy

Grondwer
Grondwer
STAART

EEMMALIC

2. Ukomtin de onderbouwing door in het onderbouwingspaneel te klikken of door [Ctrl-2] in te toetsen.

3. Klik numet de rechter muisknop in het vakje code en er verschijnt een context menu:

:I_ 3 Kopigren Ctrl+C -
post # Knippen Ctrl+X
Plakken onder de regel (niveau dieper) Ctrl+V
Plakken boven de regel (hetzelfde niveau) Shift+Ctrl+V
Kostensoorten calculatie F7
Kostensoorten/middelen calculatie Shift+F7
Kostensoorten standaard calculatie F8
Kostensoorten/middelen standaard calculatie Shift+F8
— Kostensoorten standaard bibliotheek F9
| Kostensoorten/middelen standaard bibliotheek  Shift+F9
L Standaarden F10
] * Toevoegen Ins
I =** Toevoegen niveau Ctrl+Ins

In dit menu vindt u de handelingen die u hier kunt uitvoeren met de sneltoetsen die u hiervoor kunt
gebruiken. U kunt ook gewoon kiezen in dit menu door op de optie te klikken.
4. Klik op Kostensoorten standaard bibliotheek om een overzicht van de standaardkostensoorten te krijgen.

5.  Kopieer de gewenste kostensoort (een mobiele graafmachine) door er op te dubbelklikken.
Zoek de graafmachine op door te bladeren in het overzicht met de cursor- of PgUp en PgDn-toetsen of
door gebruik te maken van de schuifbalk aan de rechterzijde van het overzicht.

Zoekmogelijkheden in het overzicht worden in de volgende paragraaf besproken.

U kunt meerdere kostvensoorten gelijktijdig kopiéren door ze te selecteren door ze stuk voor stuk

aan te klikken terwijl u de Control toets ingedrukt houdt. Klik vervolgens op [OK] om ze naar de

onderbouwing te kopiéren.

Ga met behulp van de Tab toets naar het veld Hoev.ksrt. en voer hier 8 in.
Druk op Tab

Voer 600 in (veld Hoev.post)

Druk op Tab

v o N o

U heeft uw eerste onderbouwingsregel ingevoerd.
De veldnamen en de rekenwijze komt overeen met wat u al kent uit Wecap SE.

10. Druk op [Insert] om een nieuwe onderbouwingsregel toe te voegen.
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541  Navigeren
U zit nu in de onderbouwing van post 200010. Met behulp van [Alt-Cursor-Up/Down] kunt u respectievelijk naar
de bovenliggende (Hoofdstuk 2) en de onderliggende post (200020). U blijft dan in het onderbouwingspaneel
staan waardoor u snel wijzigingen kunt aanbrengen in de onderbouwing.
Wel wordt er automatisch een lege onderbouwingsregel aangemaakt als de onderbouwing nog leeg is. Dit kan
lastig zijn als u de post wilt “afprijzen” door een eenheidsprijs voor de post vast te leggen. U dient dan eerst de

lege onderbouwingsregel te verwijderen.

Uiteraard kunt u ook met de muis de gewenste post aanklikken en vervolgens in het onderbouwingspaneel
klikken.

Alle sneltoetsen kunt u terugvinden in Help ~ Sneltoetsen.

»  Voer nu zelf een onderbouwing in bij de post 200020.

5.4.1.1 Zoeken in overzichten
In het kostensoortenoverzicht dat u oproept in de onderbouwing met [F7] tm [F10] (en dit geldt ook voor

andere overzichten) kunt u op diverse manieren zoeken om sneller de juiste kostensoorten op te halen.

Sortering

13 naar e

Door op een kolomkop te klikken kunt u de inhoud van de kolom oplopend

sorteren, klikt u nogmaals dan wordt de kolom aflopend gesorteerd.

U kunt de sortering herkennen aan het driehoekje in de kolomkop.

Springen naar een bepaalde kostensoort

Door een waarde in te tikken in het veld na de knop Ga naar en vervolgens op Enter te drukken springt u naar
de eerste kostensoort waarvan de code begint met die waarde.

Als deze niet gevonden wordt komt u op de eerste kostensoort met een hogere waarde terecht.

Hiertoe dient een oplopende sortering op kostensoortcode te zijn ingesteld.

Springen naar een bepaalde kostensoort bij het openen van het overzicht
Als in het overzicht de Ga naar knop zichtbaar is, dan kunt u al in de onderbouwingsregel het begin van de code
intikken voor u het overzicht opstart. De kostensoort beginnend met de ingevoerde waarde wordt dan direct

opgezocht.

Filteren op...

Er kunnen complexe filters gezet worden op de kostensoorten. Het meest Kostensoorten Kostprijs.1.vm

gebruikt wordt echter een eenvoudig filter op de omschrijving van de oo < o010

kostensoorten. g N
Filteren op

er

Laatst gebruikte

Om een filter te kunnen zetten klikt u op de knop Ga naar om deze te wijzigen:
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Nadat u hier gekozen heeft voor Filteren op kunt u in het veld erachter een tekst opgeven en op Enter drukken.
Alleen kostensoorten waarvan de code of de omschrijving deze tekst bevatten worden dan weergegeven.

Zo kunt u bijvoorbeeld snel alle betonbuizen weergeven.

Laatst gebruikte
Als u het menu van de Ga naar knop opent en kiest voor laatst gebruikte, wordt er bijgehouden wat de laatst
gebruikte kostensoorten zijn. Als u dit overzicht later opnieuw opent worden dan alleen de laatstgebruikte

kostensoorten getoond.

Instellingen
Om deze functies nog beter te kunnen gebruiken kunt u instellen hoe het overzicht geopend dient te worden.

Klik op de steeksleutel rechts boven in het overzicht op de instellingen te benaderen.

5.4.2  Kopiéren uit eigen calculatie
Kopiéren van (delen van) onderbouwingen kan op diverse manieren.
Misschien wel de meest eenvoudige manier is het werken met de standaard toetsen voor selectie en kopiéren:
1. Gain de onderbouwing van post 200010 staan
2. Selecteer alle regels door [Ctrl-A] in te drukken
3. Drukop [Ctrl-C] om de regels op het klembord te zetten
4. Gainde onderbouwing van post 20030 staan
5

Druk op [Ctrl-V] om de regels vanaf het klembord in de onderbouwing te plakken

Werkt u liever met de muis:

1. Gain de onderbouwing van post 200010 staan

2. Selecteer alle regels (Klik de eerste aan, druk de Shift toets in en klik de laatste aan)
3. Sleep nu de regels naar post 200030
4

Druk de Ctrl toets in en laat de muisknop los

5.4.3  Kopiéren uit andere calculatie(s)
Om te kopiéren uit een andere calculatie dient u deze eerst te openen:
1. Kies Vensters » Projecten
2. Open een tweede calculatie

3. Kiesvervolgens Vensters » Horizontaal of Verticaal (wat u het plezierigst vindt)

Beide calculaties worden nu getoond. U kunt nu posten verslepen van de ene naar de andere calculatie. Een

post die u zo sleept wordt gekopieerd, het origineel blijft dus staan.

5.4.4  Kopiéren uit de standaard calculatie of bibliotheek
Als u wilt kopiéren uit de standaard calculatie of de bibliotheek kunt u deze oproepen met respectievelijk F8 en
F9. Plaats vervolgens de vensters op de door u gewenste wijze en kies Vensters » Positie standaard bibliotheek
(calculatie) opslaan. In het vervolg zullen de vensters dan op deze positie en met deze grootte geopend

worden.
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54.5 Eindblad
In Wecap XE is het eindblad in de calculatie opgenomen. Er is dus geen apart staartblad.
Het is mogelijk een standaard eindblad in te richten in de standaardcalculatie, zie hiertoe de help.
In de geopende calculatie is de staart van het bestek ingelezen. Als u een staart standaard inricht wordt deze

samengevoegd met de staart van het bestek.

U kunt nu de staart gaan invullen:

1. Ganaar post 910010 voer als omschrijving “Inrichten werkterrein” in.
Voer vervolgens een onderbouwing in.

2. Ganaar post 910020 en voer als omschrijving “Leveren en plaatsen reclameborden” in
Hiervoor hebben we een prijs van een leverancier gekregen, we willen deze post dus afprijzen.
Ga naar de hoeveelheid en geef de prijs in (bv. 685,00) Voer bij ehd.prijs 1,00 in

3. Ukunt nu zelf nog meer eenmalige posten invoeren en de uitvoeringskosten

4. Ganu naar post 939990 Algemene kosten
AK wordt vaak uitgedrukt in een percentage. Dat gaan we nu ook doen.

Klik op de tab Postinformatie rechts van het postenvenster.

Calculatie Inschrijfstaat
Subtotaal 5.000,00
T Staart 0,00

Imnrufm Kostprijs T 500000 Subtotaal 5.000,00
Indirecte kosten 0,00  Staart 0,00
] 500000 Aznneemsom 0 5.000,00
Post informatie = |[F
5.000,00 Bt
Inschriffstaat H

ﬂ,m Commentaar O

Eenheidspost | =

3 .{H}D,{HZI' Stelpost O

= Bewaking |

a Staart

=] T 0

= Activiteit |

E Postafhankelijk O

‘__3:1 Readonly O

3 Verkoop fixeren O

5T} [ Variant O

% Actief O

E] Staartpost rekenmethode
Onderdeel totaal O
=i

Wanneer deze niet zichtbaar is kan W& orden getoond door de toetscombinatie Ctrl+3

5. Erverschijnt nu een extra venster met postkenmerken
6. Indit scherm klikt u de optie “Opslag” aan. Controleer of “Directe kosten" is aangevinkt.

Ga nu naar het veld Hoev. op de postregel en voer hier 7 in ( 7% over de directe kosten)

Tip: Als u Algemene kosten uitdrukt als een percentage van de omzet dan kunt u postkenmerken

instellen als hieronder bij de contributies!

7. We gaan nu de contributie vastleggen, ga hiervoor op post 960010 staan

8. Open het Postinformatievenster

9. Klik de optie “Onderdeel totaal” aan

10. Voer nuin de kolom “Hoev."” de waarde 0,15in (0,15 % van de aanneemsom)
11. Voer nu post 960020 in.

Wecap XE kent erg veel mogelijkheden voor het omgaan met opslagposten. Veel wordt er geregeld in

het postinformatiepaneel. Meer hierover leest u in de help onder “Rekenmethoden”.
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5.4.6  Afdrukken
Wecap XE kent diverse afdrukken voor de calculatie. Ook kunt u een afdruk van de op het scherm getoonde

gegevens maken. Hierdoor kunt u eenvoudig een andere kolomindeling op de print krijgen. Het is zelfs mogelijk

zelf rapportages te definiéren.

1. Klik op de printer knop om de afdrukdialoog te starten.

ha Wecap XE - [Calculatie Kostprijs.Kostpri
i Bestand Bewerken Beeld View Ex|

Kostprijs + Inschrijvingsstaat

Profect by de huidige calculatie af (Ct]
Calculatre——wostprs=mostprgs =1

2. Kies de optie Rapportage en controleer of in de regel er onder "RAW calculatie” staat.
Zo niet selecteer deze dan in de pulldown lijst door op het pijltje te klikken.

3. Klikop OK

4. De afdrukinstellingen dialoog wordt geopend

Afdrukken X
Afdrukken posten: Afdruk op basis van hierarchische sortering:
@ Alle |caLcuLaTECODE v

() Geselecteerde

Afdrukken:

[OMemca's Recapitulatie calculatickolommen
[ Voorblad Kostensoorten
Posten Indirecte kosten

[JRecapitulatie posten Valuta

[F Details...

E Vool?&eld i | PDF | | oK | | Annuleren | | Help |

¥
5. Klik op Voorbeeld om het afdrukvoorbeeld te starten

6. U kuntvanuit het afdrukvoorbeeld afdrukken, exporteren naar PDF of (door op Annuleren te klikken) terug

naar de calculatie.
Printer wijzigen

U kunt de printer in Wecap XE niet vanuit de printdialoog aanpassen.

Dit kan alleen via Bestand » Afdrukinstellingen...
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INSCHRUVINGSSTAAT

5.5 InSChrijVinQSStaat hoev.rﬁ.verpl.hl" | prijs per ehd.l totaalbedrag|
De inschrijvingsstaat wordt terwijl u calculeert gevuld. 216.907.50

. . - . L 50,00 1,00 50,00

Uiteraard kunt u de inschrijvingsstaat naar eigen inzicht 570,00 > 12.05 6.982,50
aanpassen. 570,00 F 250,00 142.500,00

. . . L 95,00 260,00 24.700,00

»  Wijzig een eenheidsprijs in de kolom Inschrijvingsstaat 25,00 425,00 1027500

*  Wijzig een totaalbedrag in de kolom Inschrijvingsstaat 2.300,00 1,00 2.300,00

Al u een waarde wijzigt in de inschrijvingsstaatkolom dan komt er een handje bij te staan ten teken dat u

dit handmatig gewijzigd heeft. Wijzigt u naderhand een post in de calculatie dan worden de handmatig
aangepaste waarden niet bijgewerkt!

Om de inschrijvingsstaat weer bij te werken met calculatiegegevens moet u met de rechter muisknop klikken in
de Inschrijvingsstaatkolom en kiezen voor de optie “Verkoopkolom vullen vanuit kostprijskolom”.

U kunt ook specifieke regels weer terugzetten door de handmatig ingevoerde eenheidsprijs te verwijderen.

5.5.1  Afprijzen van de aanneemsom

Om de aanneemsom in één keer op een gewenste inschrijfsom te zetten:

Afprijzen totaal calculatie

—

Kies in het menu voor Extra » Afprijzen totaal calculatie.

Selecteer in het pulldown menu de optie Totaal verkoop

Totaal verkoop ~ 3

Voer het gewenste bedrag in. Het verschil wordt direct bijgewerkt. Totaal
Totaal (incl. btw)

AW

Geef nu aan welke posten aangepast dienen te worden. Dit wijkt

Totaal verkoop (incl. btw
() Geselecteerde

sterk af van wat u gewend bent uit SE. U kunt in Wecap XE namelijk

het verschilbedrag over vrijwel alle posten verdelen.

() Met verrekencode:

5. Klik in deze dialoog op de knop Help om een helpscherm over deze
functionaliteit te krijgen.

6. Klik op de knop OK om de wijzigingen door te voeren.

5.5.1  Bewerken van eenheidsprijzen
U kunt bewerkingen op de eenheidsprijzen in de inschrijvingsstaatkolom uitvoeren als procentuele verhoging,

afronding etcetera.

1. Klik met de rechter muisknop op de inschrijvingsstaatkolom en kies “Afprijzen eenheidsprijzen verkoop”
2. Geefaan wat u wilt wijzigen
3. Klik op [OK]

551  Afdrukken

Klik op de printer knop om de afdrukdialoog te starten

JEEN

Kies de optie Rapportage en selecteer "RAW inschrijfstaat” uit de lijst door op het pijltje te klikken.
Klik op OK
De afdrukinstellingen dialoog wordt geopend

Klik op Voorbeeld om het afdrukvoorbeeld te starten

A

U kunt vanuit het afdrukvoorbeeld afdrukken, exporteren naar PDF of (door op Annuleren te klikken) terug

naar de calculatie.
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5.6 Bediening algemeen

5.6.1  Vensters en Panelen
Binnen Wecap XE wordt veel gebruik gemaakt van vensters en panelen. Binnen Wecap XE worden ze beide
vensters genoemd. Veel van deze vensters kunt u op verschillende manieren zichtbaar maken. Als u dit

document gevolgd heeft bent u ze allemaal al tegengekomen.

Als zwevend venster

Denk hierbij aan het kostensoortenvenster dat u oproept vanuit de onderbouwing. Nu is dat geen gewoon

venster maar een dialoogvenster, maar de weergave is gelijk.

Gedockt venster

Het onderbouwingspaneel is een zogenaamd gedockt venster. Het is vastgezet aan de onderrand van het

Wecap XE venster.

1. Dubbelklik op de tab “Onderbouwing"”. Het onderbouwingspaneel wordt nu als zwevend venster
weergegeven.

2. Sleep vervolgens het onderbouwingspaneel naar beneden tot dat er een schaduwrand aan de onderkant
van het Wecap XE venster verschijnt. Laat de muis nu los en het onderbouwingspaneel is weer gedockt. Dit

kunt u doen met alle vensters die aantreft in het menu “Beeld”

roer T TOuTON Y Tou ToUT Lacdad U IO Tow ToU T T
910020 Opruimen van werkterrein 1.500,00 EUR N 1,00 1.500,00 EUR 1.500,00 N 1,00 1.500,00

918870 Korting 100 EUR N EUR N 1,00

918880 Overige eenmalige kosten 100 EUR N EUR N 1,00

0 1.686,%

Onderbouwing [ |

hoev.ksrt. | hoev.post|  hoev.heid|ehd.

EI
N 345825
| Productienorm: 0,00

|
a
x

ELR 186,96

<

+~ ONDERAANNEMING ONDERAANNEMING
- DIVERSEN DIVERSEN

Een automatisch verbergend venster

Een voorbeeld hiervan is het postinformatiepaneel.

U kunt van ieder gedockt venster een automatisch verbergend venster maken door op de punaise te klikken.
1. Klik op de punaise in het onderbouwingspaneel

Het paneel verbergt nu automatisch. U kunt het zichtbaar maken door op

de tab te klikken. O 0 =

2. Klik nogmaals op de (nu liggende) punaise in het onderbouwingspaneel.

3. Het paneel blijft nu continue zichtbaar.

4. U sluit venster door op het kruisje rechtsboven in dat venster te klikken.

U kunt ze nadien weer openen door ze te kiezen in het menu “Beeld".
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VanMeijel levert software en diensten voor project-, financieel-, )
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